
aniMate2 User Guide
We are always looking for way to improve our documentation and videos. If you have questions please let us know.

We have included videos for each section of the User Guide. Any time you see this icon... , click on it to
watch.
 

The Basics - Overview of Our Approach to Animation
AniMate2 takes a building block approach to 3D animation. Animations are broken down into editable chunks (aniBlocks) that can be stored and
reused similar to the way video clips are used in a video editing application.  Just as video editing software doesn’t care how the video clips were
created, aniMate doesn’t care where the animation clips were created either. AniMate2 is a DAZ Studio plugin and can only be used within DAZ
Studio. A DAZ Studio scene is made up of a collection of objects. Objects are things like characters, cameras, lights and props. All objects in a DAZ
Studio's scene can be aniMated with aniBlocks.

AniMate2 was designed to be as easy to use as is possible, with special emphasis on human/character movement.  The "blocked" nature of
aniBlocks allows you to create compelling animated scenes with great ease.  aniMate2 has expanded on this to allow the following:
- Sub-tracks that allow for morphs/pose aniBlocks layered on top of a base track.
- Sub-tracks that allow for overriding body parts to facilate such things as waving while walking.
- Easy adjustment of existing aniBlocks using Keyframe Levels.
- Easy creation of Morph and Pose Offset aniBlocks.
- Creation of Full Motion aniBlocks.  
 

Where do I find my aniMate2 Stuff after install? 
The aniMate2 installer puts files in the following places:

DAZ>Studio>plugins>aniMate2.dll
DAZ>Studio>content>aniBlocks>aniMate>
(sample aniBlocks)

DAZStudio>Plugins>libaniMate2.dylib
DAZStudio>Content>aniBlocks>aniMate>
(sample aniBlocks)

These are the STANDARD installation locations. If you have installed DAZ Studio in a NON-STANDARD location, AND aniMate gets
installed in this STANDARD location you will have a problem. Two plugin folders will be created, one with all the normal stock plugins that
come with Studio that you see when you start it up, the other with the aniMate plugin, not being seen by Studio. To solve this problem you
need to find both plugin folders (do a search for "plugins" ), then put the "libaniMate2.dylib"(mac) from one "plugins" folder into the other
"plugins" folder with all the other .dylib(mac) files. Now you should be able to see aniMate2 as described below.

 

Once installed, aniMate2 will show up inside DAZ Studio as a tab. Go to View/Tabs and you should see "aniMate2". AniMate2 was designed to dock
at the bottom of your DAZ Studio window, but you can put it wherever you would like. Now that you've found the plugin, we should probably tell you
where to find your aniBlocks inside of Studio. There are two places you can browse for aniBlocks and then drag them into the aniTimeline. First, you
can browse to them in the normal DAZ Studio content browser. The other way is to use the "aniBlock Previewer".

aniBlock Previewer
The Previewer by default should
show up underneath the aniTimeline
but if it is hidden you can always
show it by right clicking on any
"blank" space inside the aniMate2 tab
and selecting "Preferences". Check
the box next to "Show Previewer". Of
course, unchecking this box turns the
Previewer off.

The Previewer is a great way to
search for aniBlocks because when
you roll over the aniBlock it animates
the current character you have
selected so you can see exactly what
you are getting before you drag it
onto the timeline. 

By clicking on the "Folder Dropdown" you can see all the folders located at "DAZ>Studio>Content>aniBlocks". After picking a folder, the aniBlocks in
that folder will appear in one row along the bottom of the aniMate2 tab. They are displayed in a very condensed, space saving way but they will
expand to reveal their names as you roll your mouse over them. After previewing aniBlocks that you like, just drag and drop them into the timeline. A
red line will show you where the aniBlock will start after you drop it.

 

https://web.archive.org/web/20190902122134/http://gofigure3d.com/site/vids/amp/after_install.mov


The aniTimeline 

 Scrubber
The scrubber's location indicates what point in time is
being shown in the 3D viewport, AND what frame you
are currently editing. You can preview your animation
by clicking and dragging the scrubber along the
timeline in either direction.

 Scrubber Stop
This little square can be moved anywhere along the
timeline. When the scrubber reaches it, the scrubber
is sent back to the first frame of the current play
range. It is set by default to
automatically move to the end
of the last aniBlock in the
timeline. If you move the
scrubber position manually,
the "Auto Adjust" is turned off until you turn it on
again. You can turn the Auto Adjust on and off by
right clicking on it and toggling it.

 Play Range
The play range is adjusted by using the "Play Range"
scroll bar and the "Zoom" scroll bar. Basically, the
visible portion of the animation tracks is the play
range. The scrubber will only play within the play
range.

 Zoom
The zoom scrollbar expands or condenses the
amount of time you can see in the aniTimeline. You
can also use your mouse's scroll wheel on the
Timeline to zoom in and out.

 Play/Stop
This starts (or stops) moving the scrubber forward in
time.

 First Frame
Moves the Scrubber to the first frame of the
aniTimeline

 Last Frame
Moves the Scrubber to wherever the "Scrubber Stop"
is, OR the end of the Play Range (whichever is first).

 Loop
Sets the Scrubber to loop through the Play Range

 
 Next Frame

Moves the Scrubber to the next frame.

 Track
A row (for containing aniBlocks) in the aniTimeline
that is assigned to a specific object in the scene.
Each object in your scene can have its own Track. A
Track can have multiple Sub-Tracks that can blend
with or override its animations. Tracks can be
collapsed to hide its Sub-Tracks by clicking the small
triangle next to the Track's name.

 Sub-Track
A Sub-Track has all the characteristics of a Track but
is a child of a Track and any aniBlocks in it will affect
the aniBlocks of its parent Track (if it is enabled).

 Add/Delete Track
The add button (+) adds a new track for the currently
selected scene object. If the currently selected scene
object already has a Track it will add a Sub-Track. If
you have a Track or Sub-Track selected this button
will add another Sub-Track. The delete button (-) will
delete the currently selected Track/Sub-Track

 Active/Inactive
This button(s) allow you to make a Track inactive.
When a track shows an "X" by it, it is inactive and will
not be used when you play your animation. 

 Lock Track
This button(s) allow you to lock a Track so that it is
protected from any changes.

 Contextual Tool Area
This area will contain tools for whatever is selected in
the UI. For instance, when you select an aniBlock,
this area will fill with aniBlock editing tools.

 Play Range Scroll Bar
Use this scroll bar to adjust what portion of the
timeline you can see (and therefore what your Play
Range is).

 Move Track
Use these arrows to move Tracks and Sub-Tracks up

https://web.archive.org/web/20190902122134/http://gofigure3d.com/site/vids/amp/timeline.mov


when playing.

 Previous Frame
Moves the Scrubber to the previous frame.

 Frame Counter/Frames Per Second
Shows you the frame
number (of the current
second) that the Scrubber is
on. By right clicking on the
Frame Counter you can
change the frame rate of
your animation. Frames Per
Second (FPS) can be set to
12 15, 24, 25, 30, 60 or 100.

and down in the stack.

To Add a New Track:

1. Select a new object via the scene tab or by selecting it in the main viewport.
2. Click on the "New Track/Sub-Track" button or right click anywhere on the aniMate2 tab (other than on the Timeline) and select "Add
Track"

 
 

aniBlocks 

 
What are aniBlocks?
AniBlocks are containers for animations of any length (from a one-frame pose to a lengthy dance) that can come from multiple sources and that are
saved in a unique format. An aniBlock in the aniTimeline automatically blends with the aniBlocks that are next to it. AniBlocks made in aniMate2 can
contain skeleton or bones animation for complex characters, animation for simple objects like cameras, lights and props and they can also contain
morph based animation.
 

Moving aniBlocks Around on the Timeline 

AniBlocks are moved by grabbing the middle of the block
and dragging it along the timeline. Multiple aniBlocks can be
moved at once by shift-clicking them and then dragging.
There are two different "Layout Modes" that affect how
aniBlocks interact when you move them around in the
timeline. The default layout mode is "Sparse". In Sparse mode you can put aniBlocks anywhere you want along the timeline leaving gaps. The other
mode is "Packed". In Packed mode the aniBlocks all stack together with no gaps starting with the beginning of the timeline. When dragging an
aniBlock in Packed mode it assumes you want to switch the position of that aniBlock with another. You will see a red line appear where the aniBlock
will be placed when you drop it. You can move aniBlocks between tracks by holding down the shift key. This is also the way to change the order of
aniBlocks on their own track in Sparse mode.

 

If you have gaps between aniBlocks in Sparse mode
and you slide an aniBlock into another  it will push that
aniBlock until it hits another  and so on and so
on.When there are no more gaps  it will start switching
places with aniBlocks as you push against them .

To change "Sparse" to "Packed", right click the track and
choose Layout>Sparse or Packed.

NOTE: The Parent/Base Track's default mode can be switched from "Sparse" to "Packed" mode by right clicking on any open space on the
aniMate2 tab to access the Preferences Dialog Box and then checking the box next to "Base track defaults to packed layout". The default for
sub-tracks is always "Sparse".

 

 

How are aniBlocks edited?

https://web.archive.org/web/20190902122134/http://gofigure3d.com/site/vids/amp/moving_blocks.mov


In order to edit an aniBlock it must be in the timeline and it must be selected. You select an aniBlock by clicking on it. When an aniBlock is selected,
it's appearance changes as diagrammed in the image below.  By shift-clicking, you can select multiple aniBlocks at the same time.

Editing Length and Blend 
An aniBlock’s length can be changed in a nondestructive
way by grabbing a handle at either end and sliding it along
the timeline. As you change its length, the aniBlocks to the
right will move to adjust for its new length. When you
lengthen an aniBlock past its default length it will loop back
(and blend) to its animation’s starting point. In order to help
you keep track of how long the default length of an
aniBlock’s animation is, each loop is separated by a black vertical line.
 
When you shorten the length of an aniBlock you are not cutting the actual animation that the aniBlock contains but you are hiding a portion of the
animation so that it is not played.

After single clicking an aniBlock it will look like this. The bar below the aniBlock with the green gradient and the
white arrow is the aniBlock's blend adjuster. The new blending formula for aniMate2 is very good and will usually not need to be adjusted but you do
have the option by dragging the arrow to lengthen or shorten the time it takes to completely blend from the previous block. You can turn blending
completely off by sliding it all the way to the left (no green showing).

There is also a blend handle that shows up for internal loops. This handle controls all loops, so for
instance, if you have an aniBlock that you stretched out to reveal 4 iteration (loops) of the animation, the first loop would have a blend handle that
could be adjusted. That adjustment would be used for blending between each of the 4 loops.

 
 
 
 

Block Mode Editing 
When you single click on an aniBlock you enter "Block Mode". A new set of tools show up directly above the timeline as illustrated below.

When you edit an aniBlock in "Block Mode" you are editing the aniBlock as a whole and not the individual keyframes inside it. While some of the
tools described below certainly affect the keyframes (for instance "Reverse" switches the order of the keyframes) you are not "editing" individual
keyframes. To edit individual keyframes you will need to be in "Keyframe Mode".

 Keyframe Mode:
This allows you to enter keyframe mode of the

 
 Crop aniBlock:

The Crop tool can be seen as doing two things. First,

https://web.archive.org/web/20190902122134/http://gofigure3d.com/site/vids/amp/edit_length.mov
https://web.archive.org/web/20190902122134/http://gofigure3d.com/site/vids/amp/block_mode_toolbar.mov


currently selected aniBlock.

 Speed:
This tool allows you to adjust the speed the aniBlock
will play. 50% would mean the aniBlock will animate
the character at half speed and take twice as long to
complete. You'll notice that as you adjust the speed,
the aniBlock's length will adjust accordingly. If there is
another aniBlock after it, that aniBlock may get
pushed further down the timeline to make room for it
if it's lengthened, or a gap may be created if the
aniBlock is shortened.

NOTE: Grabbing the handle of an aniBlock and
changing it's length is not the same as changing the
length via the speed control.

 Facing Direction Offset:
This tool allows you change the facing direction (Y
axis rotation) of your character at the beginning of an
aniBlock. Let's say your character walks around a
corner and now needs to open a door, but it's not
lined up accurately to have the hand grab the
doorknob. You can use this tool to change the facing
direction of any of the aniBlocks along the sequence
to get your character perfectly aligned.

 Reorient Block:
This toggle switch is on by default. When it is on, the
horizontal position of the hips at the end of the prior
aniBlock becomes the new starting point for this
aniBlock. The facing direction of the hips at the end of
the prior aniBlock also becomes the new orientation
for this aniBlock. You may notice aniMate quantizes
this facing direction to multiples of 45 degrees. Those
that need finer control can offset this with the Facing
Direction Offset.

 Reorient Loop:
This toggle switch is on by default. It acts exactly the
same way as Reorient Block but does it for loops
inside your selected aniBlock.

 Split aniBlock: 
Press the split button when the playhead is above a
selected aniBlock at the place were you want to split
it. Your aniBlock will split into two pieces. Each piece
still has the entire animation in it so if you stretched
out the aniBlock it would be revealed. If you want to
have an aniBlock that contains a cropped animation,
you should use the crop tool next.

 Join aniBlocks:
The Join tool will make one aniBlock out of two or
more adjacent aniBlocks. To use it, select two or
more aniBlocks that are side by side and then click.
The new "combined" aniBlock will be named the
same as the first (earliest in the timeline) aniBlock in
your selection. It might be a good idea to save your
new aniBlock with a new name.

it will remove all keyframes from the selected
aniBlock that are not visible. Secondly, it rebuilds the
selected aniBlock to contain only the part that you
want to keep. Just click the button after you have
trimmed, stretched or split an aniBlock to the size you
want it.

 Reverse aniBlock:
This reverses the order of keyframes in the selected
aniBlock.

 Invert aniBlock:
Inverting an aniBlock changes all property values
from positive to negative and vice versa. This will be
more useful for morph aniBlocks. You should try it out
on a full body aniBlock if you want to see some freaky
effects. You can always hit the button again to
change it back again.

 Mirror aniBlock:
This tool allows you to mirror
the aniBlock across its X Axis.
Example, a punch with the right
hand, would become a punch
with the left hand (see image at
right). Click it again to switch
back.

 Delete aniBlock:
Probably no explanation needed here. Hit the button
and the aniBlock goes bye-bye.

This would be a good place to mention that if you hit
the delete key on your keyboard thinking that it will
delete an aniBlock, you will probably see your
character and the tracks associated with it disappear
instead. This is because we cannot take control over
certain keys from DAZ Studio (the delete key is one
of them) and so the delete key removes the selected
item from the scene. If you end up deleting your
character just hit undo and your character and tracks
will come back.

 Save aniBlock:
Clicking this button gives you the standard "Save"
dialogue box. Name your aniBlock, pick a location to
save it and then click "Save".

 Align aniBlocks:
This tool will align all the currently selected aniBlocks
to the nearest guide. Guides are the inverted
triangles found next to the zoom slider.

 

 
 



Keyframe Mode Editing
Double click on the selected aniBlock to enter Keyframe Edit Mode. In this mode you will see the keyframes of the selected block and have new tools
to use. The new toolbar looks like this:

 After you are in Keyframe Mode the aniBlock you double-clicked will look something like this...

 Exit Keyframe Mode: Click to get out of keyframe
mode.

 Level Picker: This dropdown
lets you pick what level you want
to see and/or edit. All prebuilt
aniBlocks will have animation on
the "Base" level. There are 14
other levels that you can use.
Levels are keyframe layers that
are used to offset the animation of
the base keyframe layer/level. So
let's say you have an aniBlock
where the character kicks in the
air about chest height and you
want the kick to go well above the
head. You can now go to "Level 1"
and add a new keyframe at the
peak of the kick that rotates the
leg to it's new height. You didn't
re-key the base level, you added
an offset that can easily be
adjusted or deleted altogether, leaving your original
keyframes untouched. It's a very liberating way to edit
animations without the fear of messing anything up.
In the image to the right you will notice that the Base
level has 95 keyframes, level 1 has 4 keyframes and
level 1 is the currently selected level.

 Part or All: There are two different modes you can
keyframe in, "Part" and "All". "Part" Mode only shows
you the keyframe information for the part you
currently have selected. For instance, if you have the
foot of your character selected, you only see
keyframes for that foot and no other parts of the
character. Also, when you add or delete a keyframe it
only affects the selected part. "All" mode, on the other
hand, shows you all the keyframe information for the
whole character. For instance, if you have no
keyframes set for the foot, but you do have keyframes
set for the hip, you would still see the keyframes for
the hip even though you have the foot selected. In
other words, you will not be able to see which parts
have keyframes because in "All" mode you will see

 
 Add Key: This button adds a key to the frame of

the scrubber's current location. Adding a key means
that you are saving the current values of the selected
part or parts at a certain point in time. aniMate2, like
all animation software interpolates the values (i.e.
rotation, translation and scale) of each part between
keyframes. So if you have a key set on frame 1 for
the foot, and the foot is placed on the ground and
then on frame 10 the foot is off the ground about
waist high, frames 2-9 will be filled in with new
positions of the foot that move it smoothly from frame
1 to frame 10. Note – the Add key
will only add keys for parts that are already in the
aniBlock. It will not create keys for a part that has not
already been keyed, even if that part is currently
selected.

 Zero Key: This button adds a "Zero" key to the
frame where the scrubber is currently at. A Zero key
sets the values of the keyframe on the current level to
match the values of the "Base" level. This is very
useful when you trying to adjust the animation on the
base level but only for a short segment of the
aniBlock. For instance, if you have an aniBlock of a
kick and you want the kick to be higher, you would
switch from the "Base" level to another level (like
level 1), then you would find the frame where the foot
reached the peak of the kick and raise it up to it's new
height. The foot is now higher at the peak of the kick
but it is also higher on every other frame of the
aniBlock. This would not look good if when the foot
returned to the ground after the kick it did not touch
the ground, so you would add a "Zero" key at the
point the foot should hit the ground and it will return to
the same position(on the ground) it was on the
"Base" layer. Using the Zero Key may take a little
getting used to but it is extremely handy. Note: a Zero
key only has an affect if you are a level other than the
Base level.

 Delete Key: This button deletes any keyframe
information from the frame of the scrubber's current
location.



that there is a keyframe set but it could be on just one
part or on all parts...there is no way to know. When
you add or delete keyframes in "All" mode, it affects
every part of your character. Each mode has it's
advantages and it will take you time to figure out
which mode to use in different situations.

 Graph Editor: This button toggles the Graph Editor
on and off. The Graph Editor is explained in it's own
section below.

 Save aniBlock: This button brings up the standard
"Save" dialog box where you can name and save
your aniBlock.

There are 4 values types that have unique visual indicators in aniMate2 keyframes. (Illustrated at left)

1. Rotation
2. Translation
3. Scale
4. Morph. (Note: This actually represents any value other than the first 3 but is most often a Morph.)

When you are in Keyframe Mode (aniBlock's keyframes are visible) you will notice that any adjustment
you make to your character will be reflected in the appearance of the current frame. If for instance, the
current frame is empty and you rotated the arm of your character, the top half of the current frame will
turn green. If the current frame already had a rotational value set, the value would be updated but you
would see no visual change to the keyframe. Any combination of values can exist in a keyframe.

If you are in "Part" mode, some Studio properties can be adjusted on that part, but really exist on a different one and won't show up.  "All"
mode does not have this issue.

 
Keyframe Levels
In aniMate2, all aniBlocks have a base keyframe level and keyframe levels 1-14. Levels are similiar to sub-tracks in how they work.  Levels allow for
easy adjustments of existing aniBlocks.  

Levels 1-14 are for adjustments to aniBlocks.  Levels add in their effect.  Each level is evaluated individually and then combined.  So for example, if
you have a walk aniBlock, you can add 15 degrees of bend to every keyframe in the base level by adding a single 15 degree rotational keyframe on
level 1.   The adjustment's influence can be limited/blended in by placing zero keys on both sides of the adjustment.

And good practice is to make all your adjustment to aniBlocks on level 2-14 and then flatten these adjustments to level 1.  Thus you keep the original
base level intact and all adjustments to that aniBlock are contained to the levels.

While making adjustment on levels 1-14, the "Zero" and "Key" buttons will only place keyframes on properties that already have keyframes at that
level.  For example, if you are on level 1 and you use the Studio dials to place a keyframe on the left arm to rotate 15 more degrees, the key and
zero button will put rotational keys on the left arm, but not on the right arms.  See below for the contrasting behavior.

The base keyframe level is meant for the creators of original aniBlocks.  The "Zero" and "Key" buttons will place keys on every property in the
aniBlock.  Suppose you start with an empty aniBlock with all the motion properties.   While you are on the base level, you use the Studio dials to
place a keyframe on the left arm to rotate 15 more degrees, the key and zero buttons will put more than just a single rotational keyframe on the left
arm.  They will put a keyframe on every property contained in the aniBlock.

After watching a video demo once to see how it is done, we are confident anyone can use keyframe levels to make adjustments to existing
aniBlocks.

 

 

 

Graph Editor
The graph editor allows the user introspection inside an aniBlock.  In block mode you build, in keyframe mode you adjust, in the graph editor you
understand.  Adjustments can be made with the graph editor, but level keyframing is usually better for that task.  The graph editor is excellent at
understanding what is going on inside your aniBlock and to clean things up.

The graph editor is available from the Keyframe Mode Toolbar.  Click the graph button to enter, click it again to exit.  The graph editor will take as
much vertical space as possible.  The timeline tools (scrubber, zoom, play range scroll bar) will continue to work and are in the same horizontal scale
as the tracks.

Arranged in a tree structure according the the skeletal hierarchy, the properties that are contained in the block can be seen on the left.  Expand and
collapse  the parts as necessary.  Selecting a property will display its graph.  If you select a property or part and hit the delete key button, you will be
asked if you want to remove entirely the respective properties from the aniBlock.

While in the graph editor, another zoom bar is shown.  This corresponds to the vertical zoom of the graph.  Adjust as necessary.  The mouse wheel
in the graph editor also controls the vertical zoom.

Also shown on the left is if that particular part/bone is turned on or off in the sub-track..  You can click on the setting to toggle the part on or off for the
sub-track.

Select, Move, and adjust the points on the graph.



To select, click on an open area  and drag across
the points you want, then release the mouse. You
can then click(need to hit at least one selected
point) and drag all the points together or delete

them.  The zero key button will set all the
values of the selected points to zero.

Note:  When deleting or adjusting, the
rotation properties are linked, so deleting a
keyframe in the x rotation property will also
delete the y and z.

 

 

 

 

Tracks and Sub-Tracks

 
Sub-Track Properties

The Sub-Track Properties dialog box is accessed by double clicking on a sub-track.

Mix Types
Sub-Tracks can be mixed with the Parent Track in 3 different ways.
Add (aniBlock extended influence)
Override (aniBlock extended influence)
Override (aniBlock limited influence)

Add
An "Add Sub-Track" combines the values of its aniBlocks with the aniBlocks of its parent-
track. So, if an aniBlock in the the sub-track bends the elbow at a 45º angle and the aniBlock
in the parent-track bends the elbow at a 45º angle the result will be an elbow bent at 90º
angle. An Add Track uses "aniBlock Extended Influence", which is explained below.

Override
An "Override Track" tells its aniBlocks to ignore the parent-track altogether, so whatever you
have in the sub-track overrides the parent-track animation.

aniBlock Influence Range



Extended
The influence of an aniBlock extends to the next aniBlock or to the end of the playrange.  If
the aniBlock is the first aniBlock of the sub-track its influence also extends to the beginning
of the play range. A sub-track with extended influence is useful when you want to change
the posture or positioning of your character over the length of the playrange without editing
the aniBlocks on the parent track.

For instance, you may have a character with proportions that don't match the proportions
of the character that the aniBlocks were targeted to. You can create a new aniBlock on a
sub-track that corrects (offsets) the aniBlock's problems on the parent track.

Limited
The influence of an aniBlock is limited to the aniBlock's own length. This is very handy
when you want to add an aniBlock for short or temporary changes from the parent track
animation, like "give a thumbs up", or "flash a brief smile".

 

Parts List
The Parts List allows you to pick what parts of your character will be affected by the sub-track. For instance, you can turn off all of the parts of the
lower body and only the upper body parts will mix with the animation of the parent track. A good example of how this would be useful is if you wanted
to combine...a "standing wave" aniBlock and a "walk" aniBlock. You would put the "walk" aniBlock in the base/parent track and then drop the
"standing wave" aniBlock in a sub-track set to "Override (aniBlock limited influence)". You would then turn off the lower body parts in the Parts List.
With these setting your character would walk and wave at the same time. 

 

Audio aniBlocks
Audio aniBlocks are meant to help the user synchronize the movement of their characters to audio tracks.   Click on the Audio aniBlock button, or
right click "Add Audio Block".  On Windows you can add a wav file, while on Mac a few more options are available.  Choose your file and aniMate2
will create a green colored Audio aniBlock.  You can move it around, copy, paste, change the speed, and do most things that are supported by
aniBlocks in general.  Actions that operate on keyframes are not supported and have no meaning, such as mirror, reverse, invert, etc.  

Unfortunately, audio aniBlocks will not transfer to the result of a movie render in DAZ Studio.  But many post processing tools are available for the
user to accomplish this.

The following applys to versions of Daz Studio before 3.1. If the wav file is saved (in your external audio converter) at a too high bitrate
then in aniMate, no matter where the playhead is, the sound will play from the start, which makes lip sync difficult. Saving your wav files at a
low bit rate, (like 6000hz, 16bits, stereo in WavePad), will work fine.

 

 

Morph aniBlocks
Morph aniBlocks are meant to increase expression and realism.  Most are
simple and can be created by anyone.  As an example, "v4-smile" is an
aniblock that contains one property(MouthSmile-Frown) with four
keyframes.  The first keyframe sets the property to 0, the second and third
keyframe raise and sustain the property to 100%, while the fourth
keyframe sets the property back down to 0.  Note:  this is very similiar to
how adjustment to aniBlocks are often made. 

Some morph aniBlocks are meant to loop and some include a slight
rotational aspect.  "v4-breath nod" is an example of this.  Drag the end of
that aniBlock to make it loop and the character appears to breath (make sure you have the Inflate morph loaded).  If the character is still, you will
notice the head and body seems to "nod" like a real person would.  For this and other reasons, morph aniBlocks are best put into sub-tracks that
"add"(the default).

 

aniMate2 and Studio Keyframes
aniMate2 is a plugin to DAZ Studio and as such uses as many features as Studio has to offer. With that in mind it should be mentioned that aniMate2
is focused solely on animating things in the Studio environment, while letting Studio handle everything else, including rendering movies, importing
and exporting. Studio has great features for importing BVH motions and exporting final animations in formats like Collada. In order to use these
features we rely on DAZ Studio Keyframes. You cannot directly import or export from aniMate2. Your keyframe data must first take a quick trip to
Studio keyframe land. For this reason we've included two tools in aniMate2:

Bake To Studio Keyframes:
When you complete an animation in aniMate2 that you want to export to another 3D software package,
select "Bake to Studio Keyframes" and aniMate will flatten all the tracks in the aniTimeline and put them
into Studio Keyframes. You can then export the animation by selecting "File>Export".

Create From Studio Keyframes: 
When you import a BVH file it imports into Studio Keyframes. After it's imported, select "Create From
Studio Keyframes" and a new aniBlock containing these keyframes will be added to your currently selected
base track.

 



 
Saving, Rendering and Exporting Your Animation
The terms, Saving, Rendering and Exporting often get confused and are sometimes used interchangeably but the truth is, they are all different. Let's
have a look at each one. 

Saving is what you do when you have been working on your animation for a while and you want to keep it just the way it is so that you can work on it
later. Do this by selecting "File>Save". This will save your DAZ scene including the current state of everything in the aniMate2 tab.

Rendering is what you do when you want to create a movie/video file that you can post on YouTube or send to a friend in an email. A rendered movie
file cannot be edited anymore in Studio...it's a one-way trip. Do this by selecting "Render>Render Settings", then adjust the settings as desired
(make sure you select "Make Movie") and then hit "Render". You will then be ask to name your movie and pick a location to save it (this is not the
same as the "save" in the previous paragraph). For a complete description of how to render movies in Studio please refer to Studio documentation. 

Exporting is what you do when you want to take the animation you have created in aniMate2 and work on it in another software package. You do this
by first, selecting "Bake to Studio Keyframes" (right click on any open space on the aniMate2 tab) and aniMate2 will flatten all the tracks in the
aniTimeline and put them into Studio Keyframes. You can then export the animation by selecting "File>Export". For a complete description on
Studio's export options please refer to Studio documentation.

 

aniMate2 Preferences
The Preferences dialog box is made available by right clicking on any open space on the aniMate2
tab

Options:

"Auto add tracks for skeletal characters" - By default aniMate2 adds a new track for
each skeletal character added to the scene.  If you would like aniMate2 to not do
this, disable this feature.  You can still manually add a track for a skeletal character
by double clicking on a character in the viewport and clicking the New-Track button.

"Show Previewer" - The previewer is on by default and shows up at the bottom of
the scene.  Most will want to leave this on, but in certain cases you might want to
disable it.  An example of this would be if you are working in Studio Keyframes or
importing a bvh file and you do not want aniMate2 to take over the character by
moving the mouse over an aniBlock in the previewer.

"Auto hide folder picker" - The previewer's folder picker will close itself when you
select a folder or when you leave its area.  If you would like it to remain open until

you click on the button that opened it, disable this feature.  

"Zoom auto switches keyframe/block mode" - If you would like aniMate2 to automatically switch to keyframe mode when you zoom in and exit
keyframe mode when you zoom out, enable this feature.  Even in zoom mode, double clicking is still available to switch the modes.  Some will find
that they often click on an aniBlock, double click for keyframe mode, and then zoom in to see the keyframes.  They then zoom out when they are
done and double click to exit keyframe mode.  This mode shortcuts that process.

"Base track defaults to packed layout" - By default all tracks default to a sparse layout where each aniBlock is free to be moved and space can exist
between aniBlocks.  The base track is almost always used for full motion and packed tight with no space between aniBlocks.  If you would like the
base track to default to enforce this packed tight layout, enable this option. Note: this will not change any tracks that have already been added to
aniMate2, only those that are later added.

"Default length of empty block:" - You can override the default length of an empty aniBlock when you create one, but if you always find yourself
creating 10 second empty aniBlocks, the default length can be changed for your convenience.  If you need sub second length, the crop tool is
available.  In most cases you will want to make the aniBlock larger than needed and then either crop or crop to keyframes when done.

"Create scripts for aniBlocks at startup" - To facilitate aniBlocks showing up in the Daz Content browser, scripts must be created for each aniBlock
file.  When first starting up Daz Studio, aniMate2 will check to see if all the aniBlocks under the aniBlock folder have a script file by the same name,
for those that don't aniMate2 will create them.  If you have many aniBlocks, this checking for each file could increase your startup time.  Disable this
if you do not use the Daz Content Browser, or if startup time is becoming too long.

 

aniMate2 file format
aniMate2 uses the same file format as aniMate+ and aniMate1.5. aniBlocks saved out from aniMate+ and aniMate1.5 will work in aniMate2.
aniBlocks saved out from aniMate2 will work in aniMate+ and aniMate1.5. Features of aniBlocks specific to aniMate2 will simply be ignored.

 

Right click on block in keyframe mode
Copy  - if you select an range of keyframes, this will show up and allow you to copy the keyframes.
Paste - if you had previously copied keyframes, this allows you to paste them starting at the current playhead position.
Crop To Keyframes - This finds the first and last keyframes in the block and adjusts the boundaries of the block.  When creating an aniBlock it is
often best to start with a block that is larger than needed and then crop to the boundaries of the keyframes.
Add Length - If you need more room for keyframes on an aniBlock, use this to add length.
Save as New - Save your aniBlock in aniMate2 format.
Save for legacy aniMate - This copies the information from an aniBlock and saves it in legacy aniMate format.  See aniMate2 file format for a
description.



 

Keyboard Shortcuts
SHIFT - D = aniMate2 Delete
SHIFT - C = aniMate2 Copy
SHIFT - V = aniMate2 Paste
SHIFT - Z = aniMate2 Zoom In
SHIFT - A = aniMate2 Zoom Out
SHIFT - S = animate2 Key
SHIFT - E = animate2 Zero Key

All these shortcuts can be customized using Edit > Customize, then choose aniMate2.

Constraints
Constraints use information from one or more objects in the scene to control another object in
the scene. Certain dynamics can be achieve algorithmically without the need for explicitly
keyframing the desired result. As an example, a ball which is picked up and held by a
characters hand has a parented dynamic for a certain amount of time. Doing this explicitly with
keyframes is tedious. Creating a parent constant and keyframing it on and then off is almost
always much easier than keyframing the position and rotation to mimic a parent child
relationship.

All constraints have at least one source and one target. The constraint, when active, will
calculate information based on the source and alter the position and/or rotation of the target.

The following constraints are available

Parent* – useful for picking things up. The position and rotation of the target will be
altered as if it was a child of the source.
Position – If one source, then the target will be put at the exact position of the target. If
there are two sources, the target will always be at the midpoint. This is useful for when
the sources would move during this time.
Follow* – As if there was an invisible pole that connects the target to the source. It will
always maintain the distance between the two when active.
String* – Like follow, but instead of a pole between the two objects, a string attaches the
two objects. As long as the source is less than the distance when activated, it the target
won't move. When the source is further than the distance of the “string” then the target
gets dragged along.

*Some constraints calculate offsets and as such are meant to be used once. So if you have a
character pickup a ball and set it down using a parent constraint and you want to repeat this,
you will want to add another parent constraint for the second pickup.

Tips and Tricks
In general you want all your lateral movement on the base track.

Rotations x y z are linked. Deleting or creating a key on x will create / delete on y z

Delete key in Keyframing mode:
Deletes selected keyframes on all nodes.

Delete key in Graph Editor
A. Deletes selected node from the block (together with all rotations for that node).
B. If a point is selected (white), then just that point (together with rotation points on the same node) are deleted.


